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Introduction
This manual lists all main menu items in Cubase Essential 
for quick reference. For any further information, please re-
fer to the Operation Manual.

Cubase Essential menu 
(Mac OS X only)

About Cubase Essential
Opens a window with information about the Cubase Es-
sential version number etc.

Preferences…
The Preferences dialog contains various settings and op-
tions. The dialog has several pages that you access by se-
lecting items in the Finder-like list on the left. To make 
settings without closing the dialog use the Apply button.

Use the Help button in the dialog for information about the 
items on the selected page.

Quit
Quits the program. If there are any unsaved changes in an 
open project, you will have the option of keeping these or 
discarding them before the program quits.

File menu

New Project
This item allows you to create a new untitled project. A list 
appears, allowing you to select an empty project or a 
project template. The factory templates are preconfigured 
setups to suit various types of projects. A project can be 
saved as a template, and will then appear on this list.

After making a selection, a project file dialog appears, al-
lowing you to specify a folder where all files relating to the 
new project will be stored. Select an existing folder or 
click the Create button to create a new folder.

Open…
This item opens a file dialog allowing you to locate and 
open saved project files. Cubase Essential Project files 
have the extension “.cpr”. Several projects can be open at 
the same time, but only one can be active. The active 
project is indicated by a blue button at the top left corner 
of the Project window.

Close
Closes the active window. If the Project window is active, 
the corresponding project will be closed.

Save
Saves any changes made to the project since you last 
saved. The Save command stores the project under its 
current name and location.

Save As…
Save As allows you to specify a new name and a new 
project folder for the project. 

Save Project to New Folder…
This item allows you to save the project into a new empty 
folder. It has some additional features that can be used for 
archiving purposes.

When a new empty folder has been selected, a dialog ap-
pears where you can change the name of the project and 
set the following options:
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• You can choose to minimize audio files.
This will crop files based on the audio clips referenced in the project. As 
the clips used in the project may be references to much larger audio files, 
this can reduce the project size significantly.

• You can apply Freeze Edits.
This will make all processing and applied effects permanent for clips.

• You can choose to remove all unused files.

When you save a project to a new folder, all files relating to 
the project based on the options set will be saved in the 
new project folder. The contents of the original project 
folder will be left untouched. If you are absolutely certain 
that you do not have any further need for the original project 
files, you can delete them.

Save as Template…
You can save any project as a template. When you create 
a new project, the available templates are listed, allowing 
you to base the new project on the selected template.

Saved templates will contain everything that was in the 
original project, including clips and events.

Revert
This menu item allows you revert to the last saved version 
of a project. If any new audio files have been recorded 
since you last saved, you have the option of keeping or 
deleting these.

Page Setup…
This item opens the standard Page Setup dialog, used for 
deciding about paper formats etc., before printing a score. 
The item is only available when the Score Editor is open.

Print… 
Opens the standard Print dialog, allowing you to select 
which pages to print, how many copies of each etc. This 
item is only available when the Score Editor is open.

Import

Export

Cleanup…
The Cleanup function helps you to save hard disk space by 
locating unused files which you can delete in the project 
folders on your disk.

Preferences…

Under Mac OS X, the Preferences dialog is accessed 
from the Cubase Essential menu.

The Preferences dialog contains various settings and op-
tions. The dialog has several pages that you access by se-
lecting items in the Explorer-like list on the left. To make 
settings without closing the dialog, use the Apply button.

Use the Help button in the dialog for information about the 
items on the selected page.

Option Description

Audio File… This command lets you import audio files directly into a 
project. The imported file will be placed at the current 
cursor position of the selected audio track.

Audio CD… Opens the Import from Audio CD dialog where you can 
import audio from CDs. For details use the Help function 
in the dialog.

Video File… Opens a file dialog allowing you to import a video file 
onto the video track. You do not have to create a video 
track before importing, it is automatically created. The im-
ported video will be placed at the current cursor position.

MIDI File… You can import Standard MIDI Files of Type “0” (all data 
on single track) or Type “1” (data on several tracks). 
When you import, you can choose to import the file into 
the current project, or to create a new project.

Option Description

MIDI File… Allows you to export MIDI tracks as standard MIDI files.

Audio 
Mixdown…

Allows you to mix down and export an output bus. In Cu-
base Essential you can also export an audio track chan-
nel or any kind of audio channel in the mixer (including 
VST instrument channels, FX channels, Group channels 
and ReWire channels). The resulting mix is saved as a file 
on your hard disk, complete with effects, automation EQ 
etc., in one of several file formats.
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Key Commands…
The Key Commands dialog allows you to specify key com-
mands for virtually any Cubase Essential function, as well 
as customize existing key commands to your liking. Use 
the Help button in the dialog for information about the 
items in the dialog.

Recent Projects
This submenu provides shortcuts to the most recent 
projects you have been working with. The list is chrono-
logical with the most recent project at the top of the list.

Quit

Under Mac OS X, this item is accessed from the Cu-
base Essential menu.

This quits the program. If there are any unsaved changes 
in an open project, you will have the option of keeping 
these or discarding them before the program quits.

Edit menu

Undo/Redo
Cubase Essential offers wide-ranging, multiple Undo, al-
lowing you to undo virtually any action you perform.

• To undo the last performed action, select Undo from the 
Edit menu, or use the corresponding key command (by 
default [Ctrl]/[Command]+[Z]).
If you select Undo again, the previously performed action will be undone, 
and so on.

• To redo the last undone action, select Redo from the 
Edit menu, or use the corresponding key command (by 
default [Ctrl]/[Command]+[Shift]+[Z]).
Undone actions will be available for Redo until you perform another action 
(at which point the “Redo Stack” is cleared – see “History…” below).

History…
The Edit History window contains a graphical representa-
tion of the “Undo Stack” (the performed actions, with the 
most recent action at the top of the stack) and the “Redo 
Stack” (the undone actions, with the most recently un-
done action at the bottom of the stack). The two stacks 
are separated by a divider line.

The Edit History dialog allows you to undo or redo several 
actions in one go, by moving the divider between the Undo 
Stack and the Redo Stack (in essence, moving actions from 
the Undo Stack to the Redo Stack, or vice versa).

Cut/Copy/Paste
You can cut or copy selected events (or selection ranges) 
and paste them in again at the current cursor position on 
the original track(s).

Paste at Origin
This will paste an event at its original position, i.e. where it 
was originally cut or copied from.

Delete
This will delete all selected events.

! You can specify how many levels of Undo should be 
available with the “Maximum Undo” setting on the 
General page in the Preferences on the File menu.
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Split at Cursor
This splits selected events at the cursor position. If no 
events are selected, all events on all tracks intersected by 
the cursor will be split.

Split Loop
This splits all events at the left and right locator positions.

Range
The items on the Range submenu have the following 
functions:

Select
The items on this submenu have different functions, de-
pending on whether the regular event selection tool 
(Arrow tool) or the Range Selection tool is selected:

Event selection

Range selection

Option Description

Global Copy This copies everything in the selection range.

Cut Time Cuts out the selection range and moves it to the clip-
board. Events to the right of the removed range are 
moved to the left to fill out the gap.

Delete Time The selection range is removed and events to the right 
are moved to the left to fill out the gap.

Paste Time Pastes the clipboard data at the start position and track 
of the current selection. Existing events are moved to 
make room for the pasted data.

Paste Time 
at Origin

Pastes the clipboard data back at its original position. Ex-
isting events are moved to make room for the pasted 
data.

Split Splits any events or parts that are intersected by the se-
lection range, at the positions of the selection range 
edges.

Crop All events or parts that are partially within the selection 
range are cropped, that is sections outside the selection 
range are removed, leaving only events that are fully in-
side or outside the selection range.

Insert Silence Inserts empty track space at the start of the selection 
range. The length of the inserted silence equals the 
length of the selection range. Events to the right of the 
selection range start are moved to the right to “make 
room”. Events that are intersected by the selection range 
start are split, and the right section is moved to the right.

Option Description

All Selects all events in the window.

None Deselects all events.

In Loop Selects all events that are partly or wholly between the 
left and right locator.

From Start 
to Cursor

Selects all events that begin to the left of the project cur-
sor.

From Cursor 
to End

Selects all events that end to the right of the project cur-
sor.

All on Selected 
Tracks

Selects all events on the selected track.

Option Description

All In the Project window, this makes a selection that covers 
all tracks, from the start of the project to the end. In the 
Sample Editor, this selects the whole clip.

None Removes the current selection range.

In Loop Makes a selection between the left and right locator. In 
the Project window, the selection will span all tracks.

From Start 
to Cursor

Makes a selection from the start of the project to the 
project cursor. In the Project window, the selection will 
span all tracks.

From Cursor 
to End

Makes a selection from the project cursor to the end of 
the project. In the Project window, the selection will span 
all tracks.

Select Event This item (only available in the Sample Editor) selects the 
audio that is included in the edited event only.

All on selected 
tracks

Selects all events on the selected track.

Left Selection 
Side to Cursor

Moves the left side of the current selection range to the 
project cursor position.

Right Selection 
Side to Cursor

Moves the right side of the current selection range to the 
project cursor position.
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Duplicate/Repeat…
• Duplicate creates a copy of the selected event and 
places it directly after the original.
If several events are selected, all of these are copied “as one unit”, main-
taining the relative distance between the events.

• Selecting “Repeat…” from the Edit menu opens a dia-
log, allowing you to create a number of copies (regular or 
shared) of the selected event(s).
This works just like the Duplicate function, except that you can specify 
the number of copies.

Fill Loop
This creates a number of copies starting at the left locator 
and ending at the right locator. The last copy is automati-
cally shortened to end at the right locator position.

Move to
The following functions are available from this submenu:

Convert to Real Copy
This creates a new version of a clip (that can be edited in-
dependently) and adds this to the Pool.

Group/Ungroup
You can group several events so that they are treated as a 
single unit, meaning that if you edit one of the grouped 
events, all other events in the group are affected as well.

Similarly, you can ungroup the events by selecting “Un-
group”.

Lock…/Unlock
If you want to make sure you don’t edit or move an event by 
accident, you can lock the selected event(s). Locking can 
affect one (or any combination) of the following properties:

To specify which of these properties should be affected 
by the Lock function, use the “Lock Event Attributes” pop-
up menu in the Preferences (Editing page).

Selecting locked events and choosing “Unlock” will un-
lock the events.

Mute/Unmute
You can mute (silence) events by selecting them and se-
lecting “Mute”.

Similarly, you can unmute the selected events by selecting 
“Unmute”.

Automation follows Events
This option can also be activated in the Preferences (Edit-
ing page). It is, however, also available on the Edit menu 
for quick activation and deactivation. When activated, au-
tomation events will automatically follow when you move 
an event or part on a track that contains automation for 
them. I.e. the automation events that affect an event will be 
moved along with it rather than remain in a specific posi-
tion in the project.

Option Description

Cursor Moves the selected event to the project cursor position. If 
there are several selected events on the same track, the 
first event will start at the cursor, and the following will be 
lined up end-to-start after the first one.

Origin Moves the selected events to their original positions, i.e. 
the positions at which they were originally recorded.

Front/
Back

This function doesn’t actually change the position of the 
events, but moves the selected events to the front or 
back, respectively. This is useful if you have overlapping 
events and want to see one that is partially obscured.
For audio events, this is an extra important feature, since 
only the visible sections of events will be played back. 
Moving an obscured audio event to front (or moving the 
obscuring event to back) will allow you to hear the whole 
event on playback.
Note that it is also possible to use the “Front” function on 
the event context menu for this (although this works in a 
different way).

Option Description

Position If this is locked, the event cannot be moved.

Size If this is locked, the event cannot be resized.

Other If this is locked, all other editing of the event is disabled. 
This includes adjusting the fades and event volume, pro-
cessing, etc.
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Auto Select Events under Cursor
This option can also be activated in the Preferences (Edit-
ing page). It is, however, also available on the Edit menu 
for quick activation and deactivation. When activated, all 
events on the selected track(s) that are “touched” by the 
project cursor are automatically selected.

Enlarge Selected Tracks
This option can also be activated in the Preferences (Edit-
ing – Project & Mixer page). When activated, the selected 
tracks in the Project Window are automatically enlarged in 
height.

Zoom
The following options are available on the Zoom submenu 
on the Edit menu:

Macros
If you have created Macros, these will be available on the 
Macros submenu. A Macro is a combination of several 
functions or commands, to be performed in one go. Mac-
ros are set up in the Key Commands dialog.

Project menu

Add Track
Select a track type from the Add Track submenu to add a 
new track. The “Browse Sounds…” option opens a dialog 
in which you can search for track presets or VST presets.

Duplicate Tracks
This will create a duplicate (copy) of the selected track.

Remove Selected Tracks
This will remove all selected tracks and any parts or events 
on them from the Project window.

Hide All Automation
This closes all open automation subtracks.

Pool
This opens the audio Pool, which contains all clips (audio 
and video) that belong to a project.

Markers
This opens the Marker window. Markers store positions to 
facilitate quick navigation to important locations in a project.

Tempo Track
This menu item opens the Tempo Track Editor. For tempo 
based tracks, the tempo can follow the tempo track (acti-
vated with the Tempo button on the Transport panel), which 
may contain tempo changes.

Beat Calculator…
This opens the Beat Calculator window. The Beat Calcu-
lator is a tool for calculating the tempo of recorded audio 
or MIDI material.

Project Setup…
This dialog contains general settings for a project. See the 
dialog help for specifics.

Option Description

Zoom In Zooms in one step, centering on the position cursor.

Zoom Out Zooms out one step, centering on the position cursor.

Zoom Full Zooms out so that the whole project is visible. “The whole 
project” means the timeline from the project start to the 
Length set in the Project Setup dialog.

Zoom to 
Selection

Zooms in both horizontally and vertically so that the cur-
rent selection fills the screen.

Zoom to 
Selection 
(Horiz.)

Zooms in horizontally so that the current selection fills the 
screen.

Zoom to 
Event

This option is available only in the Sample Editor.

Zoom In 
Vertical

Zooms in one step vertically.

Zoom Out 
Vertical

Zooms out one step vertically.

Zoom In 
Tracks

Zooms in selected track(s) one step vertically.

Zoom Out 
Tracks

Zooms out selected track(s) one step vertically.

Zoom Selected 
Tracks

This zooms in vertically on the selected track(s) and min-
imizes the height of all other tracks.



10

Menu Reference

Auto Fades Settings…
This opens the Auto Fades dialog, where you can specify 
various fade options. Use the Help button in the dialog for 
details.

Audio menu

Process
Basically, you apply audio processing by making a selec-
tion and selecting a function from the Process submenu. 
For details about the functions and parameters in the vari-
ous processing dialogs, use the Help button in the corre-
sponding dialog.

Hitpoints
This submenu relates to Cubase Essential’s special Hit-
point detection functions. This is a special feature that de-
tects transient attacks in audio material and adds a type of 
marker, a “hitpoint” at each attack. Once the hitpoints have 
been correctly set, you can slice up the file which amongst 
other things enables you to change the tempo without af-
fecting pitch. 

The submenu contains the following items:

Advanced
The Advanced submenu contains the following items:

Option Description

Envelope The Envelope function allows you to apply a volume en-
velope to the selected audio.

Fade In/Out Allows you to set fade-ins and fade-outs.

Gain Allows you to change the gain (level) of the selected au-
dio.

Merge
Clipboard

This function mixes the audio from the clipboard into the 
audio selected for processing, starting at the beginning 
of the selection.
For this function to be available, you need to have cut or 
copied a range of audio in the Sample Editor first.

Noise Gate Scans the audio for sections weaker than a specified 
threshold level, and silences them.

Normalize The Normalize function allows you to specify the desired 
maximum level of the audio. It then analyzes the selected 
audio and finds the current maximum level. Finally it sub-
tracts the current maximum level from the specified level, 
and raises the gain of the audio by the resulting amount 
(if the specified maximum level is lower than the current 
maximum, the gain will be lowered instead). A common 
use for normalizing is to raise the level of audio that was 
recorded at too low an input level.

Phase 
Reverse

Reverses the phase of the selected audio, turning the 
waveform “upside down”.

Remove 
DC Offset

This function will remove any DC offset in the audio se-
lection. A DC offset is when there is too large a DC (di-
rect current) component in the signal, sometimes visible 
as the signal not being visually centered around the “zero 
level axis”. DC offsets do not affect what you actually 
hear, but they affect zero crossing detection and certain 
processing, and it is recommended that you remove 
them.
It is recommended that this function is applied to com-
plete audio clips, since the DC offset (if any) is normally 
present throughout the entire recording.

Reverse Reverses the audio selection, as when playing a tape 
backwards.

Silence Replaces the selection with silence.

Stereo Flip This function works with stereo audio selections only. It 
allows you to manipulate the left and right channel in var-
ious ways.

Time Stretch This function allows you to change the length and 
“tempo” of the selected audio, without affecting the pitch.

Option Description

Calculate 
Hitpoints

Invokes the hitpoint calculation in the Sample Editor.

Create Audio 
Slices from 
Hitpoints

Slices the event according to the hitpoints and adjusts 
the tempo of the loop to the current project tempo.

Create Markers 
from Hitpoints

Creates markers (on the Marker track) according to the 
hitpoints.

Divide Audio 
Events at 
Hitpoints

Splits the event into several events, according to the hit-
points.

Remove 
Hitpoints

This removes all hitpoints.

Option Description

Set Tempo 
from Event

Adjusts the project tempo to the tempo detected in the 
edited loop.

Close Gaps Applies time stretch to close the gaps between slices 
(typically when the project tempo is lower than the loop 
tempo).

Stretch to 
Project Tempo

Stretches the selected event(s) to fit the project tempo. 
Requires that hitpoints have been calculated for the 
event(s).

Delete 
Overlaps

Used when recording audio in Cycle Recording mode. In 
this mode, each take (cycle lap) ends up on a separate 
lane on the track in the Project window. After editing the 
takes (composing a “perfect take” for example), you can 
select Delete Overlaps to return the separate takes to a 
single lane and remove all overlapped material – e.g. only 
the material that will be played back will be visible in the 
Project window.

Option Description
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Events to Part
This allows you to create a part from selected audio 
events.

Dissolve Part
This menu item dissolves a selected audio part and makes 
any audio events it contains appear as independent ob-
jects on the track.

Snap Point to Cursor
This allows you to set the snap point to the current cursor 
position.

Bounce Selection
This allows you to create either a new clip or a new audio 
file from a selection.

Find Selected in Pool
This can be used to quickly find the clips in the Pool for 
events selected in the Project window. When this menu 
item is selected, the Pool opens with the corresponding 
clip(s) highlighted.

Update Origin
The original start position where a clip was recorded in the 
project is shown in the Pool’s “Origin Time” column. As this 
value can be used as a basis for the “Insert into Project” 
Media menu item (and other functions), you can change it if 
desired. This can be done by selecting the corresponding 
clip in the Pool, moving the project cursor to the new posi-
tion and selecting this menu item.

Crossfade
This allows you to create a crossfade between two se-
lected consecutive audio events.

• If the two events overlap, the crossfade will be applied 
to the overlapping area.

• If they do not overlap (but their respective audio clips 
do), the events are resized and a crossfade is applied in 
the overlapping range.

Remove Fades
This will remove any fades or crossfades from a selected 
event.

Open Fade Editor(s)
This opens the Fade dialog for a selected event. Note that 
this will open two dialogs if the event has both fade-in and 
fade-out curves.

Adjust Fades to Range
This allows you to adjust a fade area according to a range 
selection.

Offline Process History…
This opens the Offline Process History dialog. In the dia-
log you can remove some or all processing previously ap-
plied to a clip. See the dialog help for details.

Freeze Edits…
This allows you to make any processing or applied effects 
permanent for a clip.

MIDI menu

Open Key Editor
This opens the Key Editor for the selected MIDI part(s) or 
track(s). This editor consists of a piano-roll type graphic 
interface, with the notes shown as boxes in a grid.

Scores
This opens a submenu, allowing you to open the Score 
editor and containing several Score Editor functions. The 
Score Editor shows MIDI notes as a musical score.

Open Drum Editor 
This opens the Drum Editor which is designed especially 
for editing drum and percussion tracks.

Open List Editor
This opens the List Editor. In this editor, MIDI notes, con-
trollers and other events are shown in a list.
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Over Quantize
Quantizing is a function that automatically moves re-
corded notes, positioning them on exact note values. This 
quantizes the selected MIDI parts or notes, according to 
the current Quantize pop-up menu setting.

Iterative Quantize
Instead of moving a note to the closest quantize grid posi-
tion, Iterative Quantize moves it only part of the way. You 
specify how much the notes should be moved towards the 
grid with the Iterative Strength setting in the Quantize 
Setup dialog.

Quantize Setup…
In the Quantize Setup dialog you can make various quan-
tize settings.

Advanced Quantize

Transpose…
This opens the Transpose dialog, where you can make 
transpose settings for selected notes.

Freeze MIDI Modifiers
This function applies all filter settings to the respective 
track and takes the result as the new standard. 

Dissolve Part 
This item has two uses:

• To separate events according to MIDI channel when a 
MIDI Part contains events on different channels (MIDI 
channel “Any”).

• To separate MIDI events according to pitch.
Drum tracks typically have separate drum sounds for each pitch.

O-Note Conversion 
This function (only available if a drum map has been as-
signed for the MIDI track) goes through the selected MIDI 
part(s) and sets the actual pitch of each note according to 
its O-note setting. This is useful if you want to convert the 
track to a “regular” MIDI track (with no drum map) and still 
have the notes play back the correct drum sound.

Functions

Option Description

Quantize 
Lengths

This will quantize the length of the notes without chang-
ing their start positions. At its most basic level, this func-
tion will set the length of the notes to the Length 
Quantize value on the toolbar of the MIDI editors.

Quantize 
Ends

The Quantize Ends function on the Quantize submenu 
will only affect the end positions of notes. Apart from that, 
it works just like regular quantizing, taking the Quantize 
pop-up menu setting into account.

Undo 
Quantize

You can revert the selected MIDI notes to their original, 
unquantized state at any time. This is independent from 
the regular Undo History.

Freeze 
Quantize

There may be situations when you want to make the 
quantized positions “permanent”. For example, you may 
want to quantize notes a second time, having the results 
based on the current quantized positions rather than the 
original positions. To make this possible, select the notes 
in question and use this function.

Option Description

Legato Extends each selected note so that it reaches the next 
note. You can specify the desired gap or overlap with the 
“Legato Overlap” setting in the Preferences (Editing 
page).

Fixed 
Lengths

Resizes all selected notes to the length set with the 
Length Quantize pop-up menu on the MIDI Editor tool-
bar.

Delete 
Doubles

Removes double notes, i.e. notes of the same pitch on 
the exact same position. Double notes can occur when 
recording in Cycle mode, after Quantizing, etc. This func-
tion always affects whole MIDI parts.

Delete
Controllers

Removes all MIDI controller events from the selected 
MIDI parts. This function always affects whole MIDI parts.

Delete 
Continuous 
Controllers

Removes all continuous MIDI controller events from the 
selected MIDI parts. On/Off events, such as sustain 
pedal events, are not removed. This function always af-
fects whole MIDI parts.

Delete 
Notes…

Allows you to delete very short or weak notes. This is 
useful for automatically removing unwanted “ghost 
notes” after recording. Selecting “Delete Notes…” opens 
a dialog in which you set up the criteria for the function.

Restrict 
Polyphony

Selecting this item opens a dialog in which you can spec-
ify how many “voices” should be used (for the selected 
notes or parts). Restricting the polyphony this way is use-
ful when you have an instrument with limited polyphony 
and want to make sure all notes will be played. The effect 
is achieved by shortening notes as required, so that they 
end before the next note starts.

Pedals to 
Note Length

This function scans for sustain pedal on/off events, 
lengthens the affected notes to match the sustain pedal 
off position, and then removes the Sustain Controller on/
off events.



13

Menu Reference

Logical Presets
This submenu contains various presets that let you per-
form advanced “search and replace” operations on MIDI 
data.

Drum Map Setup… 
This is where you load, create, modify and save drum 
maps. The list to the left shows the currently loaded drum 
maps; selecting a drum map in the list displays its sounds 
and settings to the right.

Insert Velocities…
All MIDI editors feature an Insert Velocity pop-up, where 
one of five different velocity values can be selected when 
inserting notes. This menu item allows you to specify 
which five velocity values should be available on the Insert 
Velocity pop-up menu.

Reset
This function sends out note-off messages and resets 
controllers on all MIDI channels. You can use this if you 
experience hanging notes or stuck controllers etc.

Media menu

Open Pool Window
Opens the Pool.

Open MediaBay
Opens the MediaBay.

Open Loop Browser
Opens the Loop Browser.

Open Sound Browser
Opens the Sound Browser.

Import Medium…
The Import Medium dialog is used for importing files di-
rectly into the Pool.

Import Audio CD…
This opens a dialog that allows you to import audio from 
audio CDs.

Find Missing Files…
This opens the Resolve Missing Files dialog that can be 
used to find referenced files that may have been moved or 
renamed etc. 

In the dialog that appears, decide if you want the program 
to try to find the file for you (Search), if you want to do it 
yourself (Locate) or if you want to specify in which direc-
tory the program should search for the file (Folder).

Remove Missing Files
If the Pool contains audio files that cannot be found or re-
constructed, you may want to remove these:

Select this item to remove all missing files from the Pool 
(and remove their corresponding events from the Project 
window).

Delete Overlaps 
(mono)

This function allows you to make sure that no two notes 
of the same pitch overlap (i.e. that one starts before the 
other ends). Overlapping notes of the same pitch can 
confuse some MIDI instruments (a new Note On is trans-
mitted before the Note Off is transmitted). This command 
can then be used to automatically rectify the problem.

Delete Overlaps 
(poly)

This function shortens notes when required, so that no 
note begins before another ends. This happens regard-
less of which pitch the notes have.

Velocity… Opens a dialog that allows you to manipulate the velocity 
of notes in various ways.

Fixed Velocity This function sets the velocity of all selected notes to the 
Insert Velocity value on the toolbar in the MIDI Editors.

Thin Out Data This thins out your MIDI data. Use this to ease the load on 
MIDI devices if you have recorded very dense controller 
curves etc.

Extract MIDI
Automation

This option allows you to automatically convert continu-
ous controller data of a MIDI part into MIDI track automa-
tion data.

Reverse This inverts the order of the selected events (or of all 
events in the selected parts), causing the MIDI music to 
play backwards. Note though, that the effect is different 
from reversing an audio recording. With MIDI, the individ-
ual notes will still play as usual in the MIDI instrument – 
it’s only the order of playback that is changed.

Option Description
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Reconstruct
If a missing file cannot be found (e.g. if you have acciden-
tally deleted it from the hard disk), it will normally be indi-
cated with a question mark in the Status column in the 
Pool. However, if the missing file is an edit file (a file cre-
ated when you process audio, stored in the Edits folder 
within the project folder), it may be possible for the pro-
gram to reconstruct it by recreating the editing to the orig-
inal audio file.

Convert Files…
This opens the Convert Options dialog which operates on 
selected files. Use the pop-up menus to specify which au-
dio file attributes you want to keep and which you want to 
convert.

Conform Files…
This will change all selected files that have different file at-
tributes to what is specified for the project, to conform to 
this standard.

Generate Thumbnail Cache
This generates a thumbnail cache of the video, used for 
display in case of strained computing resources.

Create Folder
This allows you to create a new audio or video subfolder.

Empty Trash
To delete a file permanently from the hard disk, it must first 
be moved to the Trash folder. When clips are in the Trash 
folder they can be removed permanently by using this 
command.

Remove Unused Media
This function finds all clips in the Pool that are not used in 
the project, and either moves them to the Pool Trash folder 
where they can be permanently deleted, or removes them 
from the Pool.

Prepare Archive…
This command should be used when you want to archive a 
project. It checks that every clip referenced in the project 
is located in the same folder.

Set Pool Record Folder
This is used to designate a new Pool Record folder. Se-
lect the folder, and choose this command to change the 
Pool Record folder to the selected folder.

Minimize File
This allows you to change the size of audio files according 
to the audio clips referenced in a project. The files pro-
duced using this option will only contain the audio file por-
tions actually used in the project, which can significantly 
reduce the size of the project (given that large portions of 
the audio files are unused).

New Version
This allows you to create a new version of a selected clip. 
The new version appears in the same Pool folder, with the 
same name but with a “version number” after it, to indicate 
that the new clip is a duplicate. The first copy made of a 
clip will logically get the version number “2” and so on.

Copying a clip does not create a new file on disk, but 
just a new edit version of the clip (referring to the same 
original file).

Insert into Project
This allows you to insert clips selected in the Pool into the 
project, at the current cursor position or at the clip’s Ori-
gin position.

Select in Project
With this function you can find out which events in the 
project refer to a particular clip in the Pool. Select the clip 
in the Pool, and use this menu item. The corresponding 
event(s) will then be selected in the Project window.

Search Media…
You can perform a search of the Pool to locate particular 
clips. You can specify various criteria to match in the dia-
log that appears.
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Transport menu

Transport Panel
This opens the Transport panel.

Locators to Selection
This will set the locators to encompass the current selec-
tion or selection range.

Locate Selection
This moves the project cursor to the start of the current 
selection or selection range.

Locate Selection End
This moves the project cursor to the end of the current se-
lection or selection range.

Locate Next Marker
This moves the project cursor to the next marker position.

Locate Previous Marker
This moves the project cursor to the previous marker posi-
tion.

Locate Next Event
This moves the project cursor to the next event start or 
end on the selected track.

Locate Previous Event
This moves the project cursor to the previous event start 
or end on the selected track.

Play from Selection Start/End
This activates playback from the beginning or end of the 
current selection.

Play until Selection Start/End
This activates playback two seconds before the start or 
end of the current selection and stops at the selection 
start or end, respectively.

Play until Next Marker
This will activate playback from the current project cursor 
position to the next marker and stop.

Play Selection Range
This will play back the current selection range and stop at 
the end.

Loop Selection
This will loop playback of the current selection range.

Use PreRoll
When this is activated and you start playback or record-
ing, Cubase Essential will “roll back” a bit before starting.

Use PostRoll
When this is activated, Cubase Essential will play back a 
short section after automatic punch-out.

Start Record at Left Locator
If this is activated, the project cursor will jump to the left 
locator position and begin recording when you hit the 
Record button. If this is off (unticked), recording will start 
directly from the current project cursor position.

Metronome Setup…
Opens the Metronome Setup dialog where you can make 
various metronome settings.

Metronome On
Activates the metronome.

Precount On
Activates precount – a count-in that will be heard when 
you start recording from stop mode and the metronome is 
activated. This can also be activated on the Transport 
panel. You can specify the number of precount bars in the 
Metronome Setup dialog.

Project Synchronization Setup…
Opens a dialog where settings relating to synchronization 
can be made.
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Use External Sync 
Activates synchronization.

Retrospective Record
Performs retrospective MIDI recording. If the Retrospective 
Record function is enabled in the Preferences (Record–
MIDI page), and a MIDI track is record enabled, any MIDI 
notes you play in stop mode or during playback are cap-
tured in buffer memory. If you then select Retrospective 
Record, the MIDI notes you played – i.e. the contents of the 
buffer memory – are turned into a MIDI part on the record 
enabled MIDI track. The MIDI part will appear where the 
cursor was when you started playing.

Devices menu

Time Display
This opens a separate window showing the time display. 
This is a larger view of the time display in the Transport 
panel, showing the position of the project cursor in the se-
lected primary time format.

MIDI Device Manager
The MIDI Device manager allows you to install MIDI de-
vices. You can either select pre-configured MIDI devices 
from a list, or define a device from scratch.

Mixer
This opens the Mixer. All audio, MIDI, FX channel and 
Group tracks in a project have a corresponding channel 
strip in the Mixer, as do Output busses and any activated 
VST Instruments and ReWire channels.

Plug-in Information
The Plug-in Information window lists all installed VST and 
MIDI plug-ins, and shows various information about them.

VST Connections
Opens the VST Connections window. This where you set 
up Input and Output busses to route the audio between 
your audio hardware and Cubase Essential in various 
channel configurations (mono and stereo). 

VST Instruments
Opens the VST Instruments window, where you can se-
lect up to 16 VST Instruments. When a VST Instrument 
has been selected for a slot in the window, the corre-
sponding instrument is selectable as a destination on the 
MIDI output pop-up for MIDI and Instrument tracks.

VST Performance
This window indicates the current CPU load and disk 
transfer rate.

Video
Opens the default video player. The default video player is 
selected in the Device Setup dialog.

Show Panel
Opens a panel where you can directly select any of the 
currently available devices on the Device menu.

Device Setup…
This dialog allows you to add or remove remote control 
devices and to make various basic settings for audio and 
MIDI such as selecting ASIO drivers and MIDI ports etc.
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Window menu

Close
Closes the currently active window. If the active window is 
a Project window, the project will be closed.

Close All
Closes all windows including all open projects.

Minimize All
Minimizes all windows.

Restore All
Restores all minimized Cubase Essential windows.

Tile Horizontally/Vertically (Windows only)
Arranges the open windows next to each other on screen.

Cascade (Windows only)
Arranges the open windows in a partially overlapping 
pattern.

Windows…
Opens a dialog where you can manage and make settings 
for all open windows.

The open windows list
Selecting a window from the list at the bottom of the menu 
brings it to front.

Help menu

Documentation (Acrobat PDF format)

To read these documents, you need to have a suitable 
PDF reader application. An installer for Adobe Reader ist 
provided on the program DVD.

Registration
When you click this item, the Steinberg web page is 
opened, where you can register your product. An active 
internet connection is required.

Credits and Copyrights
Lists credits and copyright information and opens the 
Steinberg web site.

About Cubase Essential

Under Mac OS X, this menu item is accessed from the 
Cubase Essential menu.

This opens a window with information about the Cubase 
Essential version number etc.

Option Description

Getting Started Opens the Getting Started book in Acrobat pdf for-
mat. 

Operation 
Manual

Opens the Operation Manual in Acrobat pdf format.

Remote Control 
Devices

Opens the separate pdf document describing the 
MIDI remote control devices supported by Cubase 
Essential.

Plug-in
Reference

Opens the separate pdf document containing de-
scriptions of the included plug-in audio effects, MIDI 
effects, HALionOne, and their parameters.

Menu
Reference

Opens the Menu Reference (the document you have 
in front of you) in Acrobat pdf format. 


	Menu Reference
	Introduction
	Cubase Essential menu (Mac OS X only)
	File menu
	Edit menu
	Project menu
	Audio menu
	MIDI menu
	Media menu
	Transport menu
	Devices menu
	Window menu
	Help menu


